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Introduction 

 

Welcome and thank you for your purchase of the PTS Trader® automated strategy.  We 

appreciate everyone’s patience (especially our first Live Class attendees) and we are excited 

that the project is now complete and wish to express our thanks to our developer, our Beta 

testers and the rest of the ETS  staff without whom this strategy would never have been 

brought to life! 

 

Notice / Warning 
 

This notice cannot and does not disclose or explain all of the risks and other significant aspects 

involved in trading FUTURES, but you should particularly note the following:  

 

Under margin trading conditions even small market movements may have great impact on the 

customer's trading account. You must consider that if the market moves against you, you may 

sustain a total loss greater than the funds deposited. You are responsible for all the risks and 

financial resources you use and for the chosen trading system. It is important that you should 

not engage in trading unless you understand the nature of the transaction you are entering into 

and, the true extent of the exposure to the risk of loss. 

 

This product may not be suitable for all investors; therefore if you do not fully understand the 

risks involved, you must seek independent advice. All trading strategies are to be used at your 

own risk.  Traders Education, LLC is not responsible for any losses incurred as a result of 

using any of our trading strategies and/or software.  The PTS Trader® strategy software should 

never be left unattended due to many variables outside of your control such as computer or 

data failure, power outages, position mismatches, network problems, etc.  Past performance is 

no guarantee of future returns. This software should not be relied upon as advice or construed 

as a recommendation of any kind.  It is your responsibility to confirm and decide which trades 

to take.  Trade at your own risk. 

 

Background  

 

As many of you may know, we began our quest for an automated strategy shortly after the 

development and release of the (Advanced) PTS methodologies. We spent a considerable 

amount of time and resources developing what we felt would be a wonderful companion to the 

PTS set-ups.  We knew that some of our students were having trouble with execution, order 

placement and the emotional aspect behind their trading and we felt an automated strategy 

would offer the perfect complement to our PTS trading methodology.  Hence, our journey 

began… 

 

Our goal has always been to develop an automated strategy that closely emulated the manual 

trading techniques as outlined within the PTS methodology.  At last, we feel that we have 

accomplished this task by implementing the PPB and the EPB system entries as well as many 

other customizable parameter driven features. 
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Prerequisites 

 

Please note that this manual assumes a basic understanding of both the NinjaTrader® Platform 

and the PTS methods.  If you do not already have a basic understanding of the NinjaTrader® 

Platform, there are several resources provided by NinjaTrader to help you get up to speed.  For 

example, within the NinjaTrader Control Center select the Help facility and search for “Video 

Library.”  You will see a list of several categories and their associated video content: 

   

� Quick Start Guide 

� Charts  

� Control Center Window  

� Data Grid 

� Instrument Manager 

� Market Replay  

 

 

Best Practices 

 

� Do not leave the strategy operating unattended. 

� Do not plan to have the strategy trade the entire session.  The best results emulate 

David’s best practice of trading for a limited duration, reaching your goal, and stopping.  

� Do not trade live until you thoroughly understand each parameter setting and its 

respective application which should be obtained via Simulation (Sim) trading. 

 

 

Installation  

 

[Refer to the NinjaTrader website (www.ninjatrader.com) for instructions on downloading and 

platform installation] 

 

The PTS Trader® strategy is protected and licensed software that can only be operated on 

preauthorized machines.  To administer this, we require the unique NinjaTrader Machine ID 

from each machine on which it’s installed.   

 

If you have not already done so, please locate your Machine ID which can be found under the 

NinjaTrader Control Center > Help > About > Machine ID and forward this to 

support@eminitradingstrategies.com.  Make sure you provide the 32 character Machine ID and 

not your Ninja License ID.  
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To install the Strategy, please follow these instructions:    

 

If you are installing an upgrade or a new version of the software, you must first uninstall the 

older existing version of the software through the NinjaTrader Control Center and select File 

> Utilities > Remove NinjaScript Assembly.  Pick the older version of the software you wish to 

uninstall and click Ok.  You must then shut down your NinjaTrader Platform to avoid any 

software conflicts and then follow the instructions below to continue. 

 

 

Installation: Component Install 

 

□ At this point, it is imperative that you close/shut down your NinjaTrader platform 

before you begin the final installation process.  Failure to do so will result in an invalid 

file reference and possible corruption of the strategy. 

□ Once you have navigated to our website/forum and are presented with the file for 

download, click ‘Save’ or ‘Save as’ and take note of the folder to which the file is 

downloaded. It is recommended that you choose your desktop as the file’s destination. 

Do not rename the file.  You may now click ‘Save.’   

 

□ Once the download is complete, you should see an .exe file on your desktop similar to 

the one below (please note that final name and release version may vary): 

 

 
 

 

□ Double-click this file to begin the installation process.  

□ The installation manager will open and you will be prompted to continue. 

□ Click ‘Next’ to proceed. 

□ You will then be presented with the End User License Agreement.  Please read the 

agreement in its entirety as you must agree to the terms in order to proceed. 

□ Next, you will be presented with a “readme” file that outlines the files to be installed on 

your computer.   

□ Click ‘Next’ to proceed and begin the actual installation process. 

□ Follow any remaining prompts and click “Finish” when complete. 

 

You may now re-start your NinjaTrader platform. 
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The PTS Trader®:   Chart Application

 

 

To apply the strategy, simply right click anywhere on a chart, choose “Strategies” and scroll 

down until you see “estAdvPTSTraderV1.”

 

Please note that the “Strategies” selection will be grayed out and un

be connected to your data feed or have chart

connect to your data provider or deactivate chart

 

 

Now you may either double-click on your highlighted selection or click “new.”  This will place 

the strategy in the bottom left sub
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:   Chart Application 

To apply the strategy, simply right click anywhere on a chart, choose “Strategies” and scroll 

“estAdvPTSTraderV1.” 

that the “Strategies” selection will be grayed out and un-selectable should you not 

be connected to your data feed or have chart-trader activated. You must therefore either 

connect to your data provider or deactivate chart-trader in order to proceed. 

click on your highlighted selection or click “new.”  This will place 

the strategy in the bottom left sub-window and “activate” the parameters as illustrated below.
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To apply the strategy, simply right click anywhere on a chart, choose “Strategies” and scroll 

selectable should you not 

You must therefore either 

 

click on your highlighted selection or click “new.”  This will place 

as illustrated below. 
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Next, you will notice the variable parameters located w

below. 
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Next, you will notice the variable parameters located within the scroll menu as expanded 

 Page 6 of 19 

 

ithin the scroll menu as expanded 
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These parameters, displays and plots are all customizable and we have set their default values 

for the ES contract.  Please find their descriptions below: 

 

Parameters: 

 

Power Pullback Section 

 

� p01_PPB_SetupOn - Activates PPB set-up (True=On, False=Off) 

� p02_PPB_ActOscTicks - No. of ticks defining an Active Oscillation. 

� p03_PPB_ActOscMarkersLabelsOn - Oscillation Marker Labels (True=On, False=Off) 

� p04_PPB_EntTgtTouchCancelOn - Cancellation of order when specified profit target is 

reached. (True=On, False=Off) 

� p05_PPB_EntTgtTouchCancelTicks - No. of ticks defining profit target order cancellation  

� p06_PPB_EntTouchCancelBars -  After price ‘touches’ your order, this is the No. of bars that 

order will remain active unless filled or target reached/touched. 

 

EPB Section 

                                            

� p07_EPB_SetupOn - Activates EPB set-up (True=On, False=Off) 

� p08_EPB_InitialOscTicks - No. of Initial Oscillation ticks required to activate EPB. 

� p09_EPB_OrderOffsetTicks - No. of order offset ticks from high/low. 

� p10_EPB_HighLowResetOscTicks - No. of ticks used to determine consecutive EPB resets. 

� p11_EPB_InitialMaxSetups - No. of EPB's per cycle when Secondary Filter is off.  This will 

default to 1 when Secondary Filter is activated. 

� p12_EPB_SecondaryFilterOn - When activated, this suppresses consecutive EPB's until 

"Trend" No-Zone is reached. (True=On, False=Off) 

� p13_EPB_SecondaryOscTicks - No. of Oscillation "Trend" ticks needed to activate 2nd and 

consecutive EPB's within same cycle (when Secondary Filter is activated). 

� p14_EPB_SecondaryMaxSetups - No. of secondary EPB's within same cycle.  This number is 

independent of the InitialMaxSetups (p_11).   

� p15_EPB_EntTgtTouchCancelOn - Cancellation of order when specified profit target is 

reached. (True=On, False=Off) 
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� p16_EPB_EntTgtTouchCancelTicks - No. of ticks defining profit target order cancellation.  

� p17_EPB_EntTouchCancelBars - After price ‘touches’ your order, this is the No. of bars that 

order will remain active unless filled or target reached/touched. 

� p18_EPB_EntOutsidePlot_On - For use on higher timeframes; when disabled (set to 

“False”) this suppresses entry orders that close inside of price. (True=On, False=Off)  See 

Examples below. 

 

Since this an “on bar close” system and we’re aware that some users may like to apply the 

Indicator across different markets and timeframes, we created a parameter that would allow 

the user to suppress an order should price come back and close “inside” of the EPB entry level  

on the same bar.  This is primarily for use on higher timeframes. 

 

                   P18 - On                                                          P18 - Off 

 

                                                                        

 

 

Common Parameters                       

                      

� p19_ETS_TrendLineChannelOn - Plots the Channel and Trendline. (True=On, False=Off) 

� p20_ETS_TradeZoneMinTicks - Minimum offset ticks used to determine valid NSE. 

� p21_ETS_Scenario - Allows the user to plot text on the chart next to the Strategy version 

number.   See example below. 
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Place Text into empty parameter section: 

 

 

End Result on the chart (top left corner):  

 

 

Alerts 

 

� p22_PPB_AlertsOn - (True=On, False=Off) 

� p23_PPB_AlertUpWav - etsAlert_PPBUp.wav 

� p24_PPB_AlertDnWav - etsAlert_PPBDn.wav 

 

� p25_EPB_AlertsOn - (True=On, False=Off) 

� p26_EPB_AlertUpWav - etsAlert_EPBUp.wav 

� p27_EPB_AlertDnWav - etsAlert_EPBDn.wav 

 

 

 

Display Plots 

 

� p28_ETS_CycleDotsOn - Plots a mid-line dot for each valid NSE (True=On, False=Off). 

� p29_ETS_CycleBackColorOn - Plots vertical back-color shading for each valid NSE cycle 

(True=On, False=Off). 

� p30_ETS_CycleBackColor - Defines the NSE cycle back-color  

� p31_ETS_BackColorTransparency - Defines the back-color transparency level. A Higher 

number up to 100 is darker while a lower number down to zero is lighter. 

� p32_PPB_OscTextColor - Defines the PPB Oscillation text color when p03 is enabled. 
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� p33_PPB_BackColorOn - Plots vertical back-color shading for each valid PPB signal 

(True=On, False=Off). 

� p34_PPB_BackColorLong - Defines the Long PPB back-color. 

� p35_PPB_BackColorShort - Defines the Short PPB back-color. 

� p36_PPB_BackColorTransparency - Defines the back-color transparency level. A Higher 

number up to 100 is darker while a lower number down to zero is lighter. 

� p37_PPB_PlotColorLong  - Defines the “long” PPB hash plot color 

� p38_PPB_PlotColorShort  - Defines the “short” PPB hash plot color 

� p39_EPB_BackColorOn - Plots vertical back-color shading for each valid EPB signal 

(True=On, False=Off). 

� p40_EPB_BackColorLong - Defines the Long EPB back-color. 

� p41_EPB_BackColorShort - Defines the Short EPB back-color. 

� p42_EPB_BackColorTransparency - Defines the back-color transparency level. A Higher 

number up to 100 is darker while a lower number down to zero is lighter. 

� p43_EPB_TriangleColorOn - Provides a visual cue in the form of a triangle that defines the 

NSE Oscillation ticks required to activate the EPB set-up (True=On, False=Off).    

� p44_EPB_TriangleColor - Defines the EPB Triangle color. 

                         

Message Center  

 

� p45_MsgCtr_On - (True=On, False=Off).  

� p46_MsgCtr_TextFontSize (Min=6), Sets the Message Center font size.       

� p47_MsgCtr_TextColor (Black), Sets the Message Center text color.  

� p48_MsgCtr_OutlineColor (Black), Sets the outline color of the Message Center. 

� p49_MsgCtr_BackColor (Gainsboro), Sets the background color of the Message Center.   
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Strategy Parameters 

 

� p50_Trade_Time-On - (True=On, False=Off)

duration. When set to “False,” the strategy will trade continuously, if enabled.

� P51_Trade_Beg_Time - Local time in the form of hhmmss 

specifies when the first trade 

� P52_Trade_End_Time - Local time in the form of h

specifies when the last entry can be placed

� P53_Trade_Exit_Time - Local time in the form of hhmmss (hours/minutes/seconds) that 

specifies the time in which no new orders will b

all outstanding orders are cancelled.

 

Strategy Chart Button Parameters

 

 

� P54_Strategy_On - When the “Strategy On” chart button is toggled off, any open 

closed (at market) and all outstanding orders are

Copyright©  2013 Traders Education, LLC 

 

(True=On, False=Off), Allows you to specify the strategy’s daily trade 

et to “False,” the strategy will trade continuously, if enabled.

Local time in the form of hhmmss (hours/minutes/seconds) 

trade entry will be placed.       

Local time in the form of hhmmss (hours/minutes/seconds) 

specifies when the last entry can be placed, but has no effect on existing open orders

Local time in the form of hhmmss (hours/minutes/seconds) that 

in which no new orders will be initiated, any open trades are

all outstanding orders are cancelled. 

Strategy Chart Button Parameters 

When the “Strategy On” chart button is toggled off, any open 

closed (at market) and all outstanding orders are cancelled. 
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llows you to specify the strategy’s daily trade 

et to “False,” the strategy will trade continuously, if enabled.  

(hours/minutes/seconds) that 

(hours/minutes/seconds) that 

but has no effect on existing open orders.  

Local time in the form of hhmmss (hours/minutes/seconds) that 

e initiated, any open trades are closed and 

When the “Strategy On” chart button is toggled off, any open trade is 
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� P55_Entry_On – When the “Entry On” chart button is toggled off, no new trades will be 

initiated, however, this has no affect on any 

� P56_Entry_PPBOn - This chart button toggles between the PPB and EPB set

strategy can only initiate one trade type at a time.  

� P57_Entry_EPBOn - This chart button toggles between the PPB and EPB set

strategy can only initiate one trade type at a time. 

 

 

� P58_Entry_ATM - Existing ATM used for entries a

This is the input field where you place your existing ATM name(s).  

important as all trades are managed locally via your saved NinjaTrader ATM’s and no trades 

will be taken if the ATM name in 

avoid a name mismatch is to simply re

names we used such as “etsATM1”.

 

� P59_Entry_MarkersOn - When

strategy fill price.  (Due to the nature of this strategy, 

allow for the plotting of trade markers on the same chart to which the strategy is applied.) 

� P60_Equity_MaxGainAmt - Total 

strategy will halt trading. This is inclusive of commissions when NinjaTrader is set to “Apply 

commission to PnL calculations” and appropriate commission levels have been defined.
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When the “Entry On” chart button is toggled off, no new trades will be 

has no affect on any open pending orders. 

This chart button toggles between the PPB and EPB set

trategy can only initiate one trade type at a time.       

This chart button toggles between the PPB and EPB set-

strategy can only initiate one trade type at a time.  

       

Existing ATM used for entries and trade management (case sensitive). 

This is the input field where you place your existing ATM name(s).  This is extremely 

important as all trades are managed locally via your saved NinjaTrader ATM’s and no trades 

will be taken if the ATM name in this field is not found by the strategy.  An easy way to 

avoid a name mismatch is to simply re-save your existing ATM(s) to one of the 

“etsATM1”.  

 

When enabled, a small blue triangle will plot indicating 

the nature of this strategy, please note that NinjaTrader does not 

plotting of trade markers on the same chart to which the strategy is applied.) 

Total maximum closed trade equity gain threshold whereby 

This is inclusive of commissions when NinjaTrader is set to “Apply 

commission to PnL calculations” and appropriate commission levels have been defined.
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When the “Entry On” chart button is toggled off, no new trades will be 

This chart button toggles between the PPB and EPB set-up’s since the 

-up’s since the 

nd trade management (case sensitive). 

This is extremely 

important as all trades are managed locally via your saved NinjaTrader ATM’s and no trades 

An easy way to 

save your existing ATM(s) to one of the ‘placeholder’ 

enabled, a small blue triangle will plot indicating the 

NinjaTrader does not 

plotting of trade markers on the same chart to which the strategy is applied.)      

threshold whereby 

This is inclusive of commissions when NinjaTrader is set to “Apply 

commission to PnL calculations” and appropriate commission levels have been defined.  
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� P61_Equity_MaxLossAmt - Total maximum closed trade equity loss threshold whereby 

strategy will halt trading. This is inclusive of commissions when NinjaTrader is set to “Apply 

commission to PnL calculations” and appropriate commission levels have been defined.  

� P62_AuditRptOn - Internal parameter used for troubleshooting and testing.  

 

General Parameters 

 

� Account - Sets the account to which the strategy will trade.  You will not see your “live” 

account number in this field while in global simulation mode.  

� Calculate on bar close - Due to the nature of our trading methodology(s), this should always 

remain set to “True” in order to avoid false signals. 

� Enabled - When set to “True,” the strategy will be enabled and ready to trade.  However, 

you will need to set this to “False” any time you wish to change a parameter setting and 

then re-enable before applying to the chart. 

 

**All remaining General, Fill Processing, Order Handling, and Order Processing parameters 

should be left to their default settings.** 
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Frequently Asked Questions 

 

 

1. How do I add the strategy to the chart? 
 

To add a strategy to a chart, please follow these steps: 

 

� First, connect to your data feed or broker.  From the NinjaTrader Control Center 

select File > Connect > and make your selection.  Strategies can only be added to the 

chart if a connection is established to a data feed and / or broker.  

 

� Next, open a chart.  On the NinjaTrader Control Center select File > New > Chart… 

and select the appropriate instrument, interval setting, and date range settings.  For 

example, you can select: 

 

o Instrument:  ES 06-13 

o Interval:  578 Tick 

o Days to Load:  5 

 

Once your selections are made, click OK. 

 

� Next, add the strategy to the chart.  Right-mouse click the chart and select 

“Strategies”, then select “etsAdvPTSTraderV1” from the list and click the “New” 

button. 

� Next, modify the parameters as desired.  Please review the parameter definitions 

found in this document. At this time, you will also need to select the account you 

wish to trade against.   

� Finally, click the OK button on the lower portion of the Strategy dialog to add the 

strategy to the chart and close the window. 

 

2. Can I run the strategy unattended? 

 

While we cannot make specific recommendations, we highly advise against it. Despite our 

attempts to guard against most every type of potential issue, there are certain types of 

problems that can occur outside the strategy’s control pertaining to internet connectivity,  

broker margin calls, trading platform errors, hardware malfunctions, and order mismatch or 

cancellation errors, to name a few. It would therefore be prudent that you keep a watchful 

eye on the strategy during its live operation and make sure you confirm all positions are 

closed, any outstanding orders are cancelled, and it is taken offline while it cannot be 

supervised. 
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3. Can I trade multiple charts and timeframes simultaneously?

 

No, you cannot trade the same market

cross and cancel one another

simultaneously on different charts

and other competing applications, etc.  Trading fast markets during peak times can easily 

consume your computing resources potentially making the strategy less responsive to rapid 

price changes.  Care should be taken before atte

time and certainly test a multiple market trading environment using a simulation account 

before trading live.  

 

 

4. Can I modify strategy/ATM placed 

Yes! You can manually drag your stop

strategy.  However, should you wish to close out a trade early

“Cancel/Close” strategy chart button to accomplish this

disabled.  Pressing the “Cancel/Close

cancel all outstanding OCO pending 

 

 
 

5. Can the PTS Strategy be backtested?

 

No.  Due to the nature of a locally managed 

support backtesting within their strategy analyzer.  In fact, 

managed via the strategy, you 

Strategies tab.    

 

 

6. Can I save the strategy parameter sets to a chart template?

Unfortunately, no.  NinjaTrader 

template.  However, you can disable the 

“False” and save the chart within a workspace. It should therefore come up with the same 

parameter settings when the saved 
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n I trade multiple charts and timeframes simultaneously? 

the same market on more than one chart as orders could potentially 

one another out.  However, you can trade different markets 

simultaneously on different charts subject to one’s online connection, CPU speed, memory 

and other competing applications, etc.  Trading fast markets during peak times can easily 

consume your computing resources potentially making the strategy less responsive to rapid 

price changes.  Care should be taken before attempting to load too many strategies at one 

time and certainly test a multiple market trading environment using a simulation account 

placed Target or Stop orders on the DOM?  

You can manually drag your stop or target orders on the DOM without disabling the 

.  However, should you wish to close out a trade early, you will need to use the 

strategy chart button to accomplish this, otherwise, the strategy 

Cancel/Close” button will close any existing trades (at market) and 

OCO pending orders.  

rategy be backtested? 

ocally managed ATM based strategy, NinjaTrader

testing within their strategy analyzer.  In fact, since the orders are

managed via the strategy, you will not see a PnL calculation within the Control 

parameter sets to a chart template? 

NinjaTrader 7.0 does not allow for the saving of strategies within a chart 

you can disable the strategy by setting the “Enabled” parameter to 

save the chart within a workspace. It should therefore come up with the same 

parameter settings when the saved workspace is re-opened. 
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on more than one chart as orders could potentially 

However, you can trade different markets 

nnection, CPU speed, memory 

and other competing applications, etc.  Trading fast markets during peak times can easily 

consume your computing resources potentially making the strategy less responsive to rapid 

mpting to load too many strategies at one 

time and certainly test a multiple market trading environment using a simulation account 

without disabling the 

, you will need to use the 

otherwise, the strategy will be 

trades (at market) and 

NinjaTrader does not 

since the orders are not directly 

not see a PnL calculation within the Control Center > 

egies within a chart 

parameter to 

save the chart within a workspace. It should therefore come up with the same 
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7. How do I know when the strategy is enabled for trading?

When the strategy is disabled, you will see a 

left margin of the chart and the strategy chart buttons 

 

 

When the strategy is enabled for trading

will illuminate: 
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How do I know when the strategy is enabled for trading? 

When the strategy is disabled, you will see a “(D)” beside the strategy name along t

and the strategy chart buttons will not be present: 

When the strategy is enabled for trading, the “(D)” will not be present and the chart buttons
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name along the top 

 

 

ill not be present and the chart buttons 
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8. How do I know when a strategy 

 

In addition to showing on the DOM, 

entry hash mark: 
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strategy order is sent? 

n the DOM, the strategy will superimpose a dot/bubble 
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a dot/bubble over the 
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9. Can I apply the strategy and the PTS Indicator to the same chart?  

 

It is not recommended nor advised since it only stands to consume unnecessary computer 

resources. 

 

 

10. What are the Indicators etsX1 and etsX2? 

 

These are strategy related Indicators necessary for its proper operation and cannot be 

applied or used in a standalone manner.  

 

 

 

This concludes the PTS Trader User Manual and we hope that you find the strategy beneficial to 

your progression as a trader.  Should you have additional concerns or questions, feel free to 

contact us at support@eminitradingstrategies.com.  We first recommend checking your Control 

Center > Log tab for any error messages before proceeding and all support requests must 

include a screenshot of both your chart and current parameter settings in order to accurately 

troubleshoot any potential issues.  

 

Thank you, 

 

~ETS Staff 
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